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1 The VASSAL Game Engine

VASSAL is a game engine for building and playing online adaptations of board games and card
games. It allows users to play in real time over a live Internet connection (in addition to playing by
email). It runs on all platforms, and is free for personal use. With VASSAL, you basically play like
on an actual board game against your opponent as you can see his moves and get notification of
missile fire and combat through a chat window.

VASSAL designer is Rodney Kinney.

For easier and faster communication, it is recommended to use a phone or any Internet telephony
software like Skype.

Note: VASSAL is not a video game but an "electronic boardgame". You cannot play against the
computer, combats are not resolved automatically, etc. Imagine that you are in front of real table
with actual maps and counters, dice and playsheets. Any action you would undertake in the real
world needs to be performed manually with VASSAL. The benefits are that you no longer need to
spend a fortune on eBay to play Cry Havoc, your dining table can be used to eat, you are no
longer worried about your kids destroying your set up and you can play with an opponent located
10 000 miles away.

2 Getting Started

2.1 Downloading game components

If you have not done it already, download the VASSAL engine (http://www.vassalengine.org). In
the Download section in the top left corner, pick the version compatible with your OS and install it
on your PC.

Launch the VASSAL engine. It = =l e
will create a VASSAL directory | @ rl) » sommn + 106 v s+ e v vhza ]| o 3
on your hard drive (Typically Groeniz v | G Open v Starewihr | Bun | fewfods _ = 0 ®
under Windows: C:/Users/ L Nﬂm; Dete modiied :‘rm
[Name]/VASSAL { Cytimoc || s et N
Download the Cry Havoc & ecne lc ™ »s
module from Cry Havoc Fan . Dot o o
(for instance) and unzip the file e D e e
somewhere, e.g. into your ) CoMeec s ssave

VASSAL folder (it will unpack =

into a folder named "CryHavoc" which contains the CryHavoc.mod).

Note: Don't try to double click on this file to open it: Some programs might consider its .mod
extension as a video file. It can only be opened through the VASSAL interface.

Any extensions (combat tables, - D e =)
additional maps and counters) G\l | » Computer » FB(C) » Users » e » VASSAL + et +[49][ search e 2]
should be placed in the [ext] sub- Ongrrize [ Open  Sharewithe  Bum  Newfolder )
directory created by VASSAL. T ©  Dosdebtmd  [IMspalEtmd U ThefartifiedTounxtms

) a! My Music || DiceSuppExt.mdx || Orleans1429Extmdx || TheTemplarsCastleExt.mcx
These files bear a *.mdx by Bictures e e — L Sp—
extension name. (example of Wi e Remen | R
Viking maps under Windows: By Orana (el e
C:/USQrS/[Name]NASSAL/eXt/ et |Hospitalierbtmdx | | TheFortfiedHarbor.mex

plugins <

VikingsMapExt.mdx)

TableFrExtmdx Date modified: 4/9/200911:42 PM Date created 1/9/20119:30 AM
MDX File Size: 7.95 MB

Note: This is the part of the installation where beginners stumble the most. There is nothing
difficult here. Simply read this paragraph again, check the screen capture and make sure you have
the same on your PC.
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2.2 Opening the Controls window

Start VASSAL when you double-click on the icon or pick it

in the Programs root menu.

Click on File/Open Module and select the CryHavoc.mod
file (browse your PC to find it in the directory where you

unzipped it initially).

In the Welcome window, type your name and a
password.

Note: The systems ask for a real name but any
type of name will work.

In the next window, select your play mode.
Options are:

> Start new game offline

> Look for a game online

> Load saved game

Select the first option

The next window is used to select your boards
(maps in VASSAL lingo) in the drop-down
menu.

> You will only see 3 maps (Crossroads,
Village and Forest if you only installed the
base module. Other maps will be added to
this menu as you add for extensions.

Note: You will have to restart VASSAL for

these extensions to show up in the menu.

> If you added for instance the VIKINGS

maps extension, the above menu will
display them after the first three.

Note: VASSAL displays maps following the alphabetical order of the extension names, not the

open it using the File menu.

Manymodules can be

| %) Welcome )
Steps Enter y m
1. Enter your name
2. Select play mode
3
[
Real Name: [Buxeria] f
Password:
Confirm Password: |essessese
Your password links you to your chosen side and hidden pieces.
4] Welcome X
Steps Choose Boards
1. Selectplay mode
2. Choose Boards Add row, Select board v
Add column Select board |~ |
(Crossroads
Clear Village
[Forest =
Watchtower
lAbb ey
(Capet N
[Cape2 =
4 Ll I IO}
)
———— |

maps. For Cry Havoc v3.1, we have selected a "chronological" order: The maps of Cry Havoc will
be displayed first, then Siege, Outremer, Vikings, etc.

It is possible to combine several maps in multiple ways to get various battlefields (see section 4.3).

As an example, let’s pick the Crossroads map (or board). When clicking OK in the Choose Board
window, the map will automatically be added to the general Cry Havoc module interface, below

the Controls window.

Note: Just drag the horizontal pane below the chat command line up if you cannot see it.
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2.3 Interface description

You are now on the Cry Havoc module
interface. The screen is split in 3 sections:

> Control buttons on top,

> The white zone in the middle is the
command window in which all
movements, actions and gamers'
commentaries will show up. By default,
it must display the Cry Havoc module
version number and the list of - CHavae wrsion 3.0 |
extensions available if you cannot see it, | -
just drag the horizontal pane below the
chat command line up. You can add
your own commentary in Chat mode.
Type your text in the command line
under and press Enter: Your text will be
displayed in the command window
above.

> The window with the maps at the
bottom. By default, the top left corner - ‘
with a 100% zoom is displayed. To get a view like the one on the side screen capture, use the
bottom and right cursors to scroll right and down, as well as the Zoom button in the controls
menu.

> The grey area around the maps is intended for off-map counters, if any.

2.4 Installing & moving counters
Click on the small Sir Richard icon to display the Counters window.

This window includes several tabs depending on the extensions that are installed (The base module
only displays 3 of them as shown below: Cry Havoc, Basileus and Misc).

For each tab, a drop-down menu let you choose a character in different stances (mounted or
dismounted). After selecting a class of
characters, the window will split in 2

columns to display the various names. 5| @@MM@’—‘ [&[@]e B[] ‘
Note: You may have to drag the command || ¢y = 5 ‘
window panel right to discover the counters = »

window. = —

Simply drag and drop a few counters onto i dscaues

the map and you are basically ready to play. ) 5”;{"25 |

The command window will then record your || g srees

last actions: Creation of the character, | Sramz || oyros ersion 30

location of its hex. If you move it, each . SiAan croed m 1515

action will be recorded in the same way. Sl e de122 135 o

Should you use the Zoom Out mode,
hovering with your mouse over any
character will display it in full size with its
name on top and the hex number where he
is located at the bottom.
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Right clicking on any counter gives all commands and their shortcuts:
Example : [ o oo ———

> Rotate Clockwise (CW) or Counterclockwise
(CCW) rotates the counter one direction or = — e —
the other by one sixth. | rr— ] ——

> Change Label can be used for specific actions [P ] N :
(like a Charge or Countercharge). No label is
displayed by default.

3 5| =) 100 106 | B | |- a 23 s | B

> The Decrease command will sequence the
various stances of the counter (Mounted,
Horse, Wounded Mounted, Dead Horse for
cavalry for instance). The Increase will do the
reverse. Note that some Norman knights have
an additional stance (throwing javelin) prior
to the regular mounted one.

4]

19045 Y] .

When a character dismounts, simply drag the same character on foot from the Counters window.
You will notice that any action with the counters is reported in the Controls window

2.5 Logging in
Click the Server button to display the server controls. In the Server controls, click the connect
button to log on to the VASSAL server.

Note: Some corporate security firewalls will prevent any connection, although a residential service
should have no problem.

Once connected, you should see the following indicators:
> You will see confirmation in the VASSAL Controls

X . xS S
window chat area that you have connected with the =
. Active Games Current Game
server and entered the Main Room. -
MNew Game ¢ (=3 Main Room (1)
> The Active Games section of the Server window will o CJ Main Room (1) Buxeria

indicate which players are logged on and which
rooms exist.

> If players are chatting amongst each other in the Main Room, text will appear in the VASSAL
Controls chat area.

2.6 To chat

To chat with other players, click in the entry area below the main chat display at the bottom of the
Controls window and start typing. Your text will appear in the VASSAL Controls chat area. To send
the message, press Enter on your keyboard.

You can also type while the focus is in the main map window and the typing will be echoed to the
chat entry area.

Ctrl-V will paste from the clipboard into the chat entry area.

2.7 Enter a game room

To view a scenario already being played, double-click on the room name in the Active Games
column of the Server window. To create a new game room, enter a new name in the "New Game'
field and press Enter. A list of players currently in the room you have entered will appear in the
"Current Game" column.

Al

Note: It is customary to introduce yourself when you enter a game room. Just type in the text
zone "May I enter?" If the answer is No, just move on.
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2.8 Synchronization

When you join a room, you may start chatting immediately. To see the game in progress,
synchronize by right-clicking on another player's name in the Current Game column and selecting
Synchronize from the pop-up menu. Once synchronized, all moves by other players will be
instantly updated on your on screen.

Important Note: Once you have synchronized with a game, you may scroll around the map and
inspect either player's counter stacks without interfering. However, all counter moves and die rolls
are broadcast to all other players in the room, so please be polite when observing other people's
games!

2.9 Maps

When you synchronize, the maps will appear on your screen. If using the combined window view,
the main map will appear in a panel below the chat area. If not, it will appear in its own separate
window. Maps are where all the counters are displayed and where the gaming action takes place.

Note: If you can only see part of the counters or if a map is missing, chances are you lack one
extension (.mdx files).

2.10 Starting a game

To start a game of your own, it will be necessary to create a Scenario Room by entering a new
name in the "New Game" field of the Server window and pressing Enter. Others (your opponent
and spectators) can then enter the room and "synch" in. (See the section on Setting up a Game).

2.11 Saving a game

A game can be saved at any time. In the VASSAL controls window, simply go to File - Save Game.
Provide the scenario with a name and a location on your hard drive, and press OK.

Note: It is highly recommended that you get used to saving your games while playing to minimize
the inconvenience that would result from a crash. There is no auto-save or back up feature. It is
your responsibility to save and protect your games. Note that Rodney Kidney hosts the games on
his own server and may perform routine maintenance from times to times.

2.12 Message boards

VASSAL also contains a message area that allows you to post messages or game requests on the
server. Like every other module, Cry Havoc has its own message board. In the Server window,
push the Check Messages button to view the Message Board, or push the Post Message button to
open the Message Composer window. In the Message Composer window, enter your message and
click Send to post your message to the Message Board.

2.13 Server status

The Server Status button displays all current connections to the server for all modules. By selecting
a module with your mouse, you can post and read messages from that module's message board.
2.14 Gamer status

Clicking the Looking for game button will place an exclamation mark (!) beside your name in the
Server window, indicating that you are interested in finding a game.

Clicking the Away from keyboard button will place an "X" next to your name in the Server window,
indicating that you have stepped away from your computer. An "I'm Back" window will pop up.
When you're ready to return, clicking "OK" will close the "I'm Back" window and remove the "X"
from beside your name.
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3 Game Components

The following Playing Tools are available for the VASSAL Cry Havoc module. All are accessible
either from the toolbar at the top of the VASSAL Controls window, or at the top of a Map window.

3.1 Preferences

When you first run the program, you will be prompted to enter the name by which you would like
to be known to other players. Enter a name and press OK (You may change your name later in
your Preferences settings).

Next, you will be asked to enter a password: Just enter a password and press OK. The password is
used to protect your identity during a game. It is used to determine who can see invisible or
masked counters, private windows, etc (those features are not available yet). You can pretend to
be another person by changing your password to theirs in the Preferences setting (assuming, of
course, that you know it).

In the VASSAL Controls window, set your Preferences by going to File - Edit Preferences.

3.1.1 Personal

Name: Whatever you enter in the Name field is the name that other
people will see in the Chat area of VASSAL. Use a nickname
or put your full name. It’s up to you.

Password : The password you created when you connected for the first
time.
Personal Info: Enter any personal info which you would like to make

available to other VASSAL users.

You may read another player's profile by right-clicking on his name in the Server window and
selecting Show Profile.

3.1.2 Sounds
Set sound files to be played for the events described.

3.1.3 General

Note: Only the most popular options are described here. It is recommended to leave the default
values.

Opponents can unmask my A "masked" piece is a piece that is visible to all players, but

pieces: whose details are only visible to the owning player. If enabled
in the module, this preferences setting determines whether
players other than yourself can manipulate pieces while they
are masked. (Masked pieces are not in use yet).

Center on Opponent's Move: The Center on Opponent's Move checkbox will automatically
center the map on a unit that is being moved, whether
connected to the server or reading a lodfile. (Highly
recommended!).

Use combined application Check/Uncheck this to use either a single, combined window or
window: separate windows for the various components of VASSAL.
Note that changing this setting requires restarting VASSAL.

Use Arrow Keys to Scroll: Checking this preference allows you to use the arrow keys on
your keyboard to scroll around the map window when you
have no counters selected. If this box is not selected, the
number keypad will scroll the map window.

3.1.4 Controls window font
You can specify the font and font size used in the VASSAL Controls window.
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3.1.5 Cry Havoc Controls window

&% CryHavoc controls I =R=n X

File Help

b=} 5| =) 1010 106 |

Show/Hide server «, This opens/closes the server controls window.
controls
Show/Hide the counters 0 This opens/closes the server counters window.
window
Dice Buttons 1410 | 146 There are two Dice Buttons, 1d10 and 1d6. The result of a roll
———J—— s reported along with the name of player who hit the button,
e.g.

*¥*%1d10 = 2 *** <martin>

##% 1d6 = 3 *** <martin>
Table Button If you have installed the Table extension, clicking on this
button will open the various on-screen combat tables.

& RN QE Sos| |

Save Map as PNG File | & | This will save the image of the map and counters into a PNG
file. It is the same as a screen capture except that the entire
map need not be showing on your screen.

Zoom out /| Zoom in The Zoom out / Zoom in buttons give you a scaled-down

overview of the map window.

Overview Window The map window has a corresponding Overview window. This
window shows the entire map at a smaller scale, with a
rectangle highlighting the currently-visible area in the map
window's scrollable area. Click anywhere on the overview

window to center the main map window at that point.
Line-of-Sight Thread /" LOS A Line-of-Sight thread draws a line on the board as the player

moves his mouse over a map window. Left-click once to clear
the thread and draw normally.

2a
B

File -> Edit Preferences contains a LOS tab where you may
check/uncheck the 'Snap thread to grid' preference option. If
checked this will only draw the thread to legal locations on the
map (i.e. hex centers, hex vertices and middle of hexsides).

Mark All Unmoved ' | Most counters in the module show a marker (a circled red “M”)
— after having been moved. The Mark Unmoved button at the
top of the map window deletes the "Moved" notation of all
counters on the map, Ctrl-M the "Moved" notation of only the
selected counter.

1d100 | 1d20 | 1d12 | 1d8 | 1d4 | Deploy 1 | Siege | Castel Avbrynwrthymaor || Town | Templar || Sea

Optional buttons will be displayed based on the extensions that you installed. The Deploy button is
used for off-maps counters or pieces (like the various levels of the belfry). Buttons for castle and city
maps will display a Record Sheet for siege management (see 4.10).




4 Detailed Instructions To Setup a Game

4.1 Creating a room

In order to start a new game, it will be necessary for you to create a Game Room for you and your
opponent to play. In the Server window, type the name you wish your room to have into the "New
Game" field and press Enter on your keyboard. You should now be the sole occupant of that room.
If you enter the same name as a currently-ongoing scenario, you will join that room instead.

Note: The Main Room is the meeting area for players entering VASSAL, not a place to play your
game. Although you may have a game open while in the Main Room on the server, your moves
will not be broadcast to other players.

While connected to a scenario chat room, all moves are broadcast to all players and maps are
updated automatically. You can save and restore the game to files on your local machine. If your
map and your opponent's map appear to differ (e.g. due to lost moves during a broken
connection), synchronizing by right clicking on your opponent's name and selecting "Synchronize"
will update your map to coincide with your opponent's.

4.2 Starting the game

To begin a new game (as opposed to continuing a saved game), choose File - New Game in the
VASSAL Cry Havoc Controls window. You will be prompted to choose boards as explained
below. To save the game to resume later, choose File - Save Game. To load a saved game,
choose File - Load Game and select the saved game file.

4.3 Choosing maps

When prompted with the "Choose Boards" dialog, select the boards you need for the scenario from
the drop down list. To add another board, select whether it will be placed horizontally (Add Row)
or vertically (Add Column). If the map needs to be reversed (rotated), check the Flip checkbox. If
you made a mistake setting up the maps, you can click the Clear button, to reset the window so
you can start again.

[&] Welcome ===
Steps .| Choose Boards
1. Belect play made 2
2.Choose Boards {| | Add row BIEREAT &y = =
i | Add column

o | Clear

| Help H < Prav H ext H Finish || Cancel |

Note: The system can only manage maps using the standard Cry Havoc format. Any other map,
like both Promontory 1 & 2 from VIKINGS are managed like counters. They are included in the
Misc/Overlays tab. You must add a Sea map next to a Coast map to be able to lay a Promontory
map over. Ships and the Belfry are managed in the same way.




4.4 Placement of counters

After the maps have been set up, or after you've loaded a saved game, the map window will
become visible. If not already open, hit the button in the VASSAL Cry Havoc controls window
toolbar with the small picture of Sir Richard to open the counters window.

The Counters window is organized with a asiieus | wise | e Sasions (S
. . . Cry Havoc | Cry Havoc Cry Havoc
combination of tabs, lists, and pull-down menus. | i e ]

Cutting Hamstr.
Inside Building
Mine

Open Door

On the Roof

[Foot

To place a piece on the map, select any counter |t
in the counters window and drag it to the map
window.

oac
rlakzi [E
Stakes - right
Ransom

4.4 Handling the counters

All pieces in VASSAL have popup menus for manipulating the counters. Simply right-click (Mac
users: click with the Command key held down) on the piece in a map window and select the
desired action. The popup menus are also available in counters windows, so you may change the
state of a counter before placing it on the map.

Each popup menu item has an equivalent keyboard command. To use the keyboard command,
first select a piece by left-clicking on it in a map window (or counters window). The counter will be
drawn with a thick border. Shift-click to select more than one counter at once. When you type the
corresponding key combination, the equivalent popup menu action will be performed on all
selected pieces.

In Help -> Shortcuts in the VASSAL Cry Havoc controls window toolbar, you will
find a list of all available shortcuts.

[
i
i

| o

S W
il
i

To facilitate game play, a red M marker is displayed on the right hand side of the
counter after his move is completed.

4.5 Shooting management

To shoot a missile, right-click on the A / oy

counter and use the Fire menu. \M[ “ >H(r‘

Offensive and Defensive fires EE / ,;” Loz / ; LW

automatically decrease the missile counter \ 5‘ Rotate CW CTRL R 1‘ . : 38

displayed at the bottom left of the Rotate GOW GTRL SHIFT R ﬂ A PO/
Color ALT SHIFT Y | E iy .

character.

Fire B Offensive Fire CTRL O
Charge CTRLC Defensive Fire CTRL D
i Mark Moved CTRL M Missiles Decrease CTRL SHIFT M
| Change Label CTRLL Missiles Increase CTRL SHIFT P
| Decrease CTRLQ Cease Firing CTRLF

; Increase CTRLW E - .
Delete CTRL X

0 A7 X
You can quickly manage the counter using the Missiles Decrease — Missiles Increase commands in
the menu. Le maximum number of missiles is 20.

:rz/«

Based on the type of fire, a
red and/or black « T »
marker is displayed in the top
left corner of the character.
To remove fire markers, select the Cease
Fire option in the menu.

"““k

Each action is associated with a sound.
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4.6 Charge/Counter-charge actions

You can command charges or counter-charges when right-clicking L L i
on the counter and selecting the option in the menu. i\
A "C" marker colored red (Charge) or black
(Counter-charge) will be displayed next to the
character.

1407

Rotate CW CTRLR 1
Rotate CCW CTRL SHIFT R
Colar ALT SHIFT ¥

Counter charge CTRLSHIFT C
Charge CTRLC
| Change Label CTRLL

This action is associated with a sound!

Note that a dismounted character can also charge:
This can be used to signal a character that has
performed a combat (or for any alternative rule you
would like to invent).

4.7 Stacks

Stacks can happen in Cry Havoc when:

Mark Moved CTRL M
Deciease CTRLO
Increase CTRLW
Delete CTRL X

20a

> A character moves into a hex containing a dead character.
> A marker is used above or below the character.

The contents of stacks can be changed in their order from top to bottom by selecting a counter and
using the arrow keys.

Markers can be positioned anywhere on top of the character, which can be helpful to keep on
viewing combat values or for the kneeling marker to match its correct position.

Note: All the actions that can be performed with a counter have not been detailed in this manual
to make it more straight forward. If you want to know what action can be performed with a
counter, just right-click it and choose.

4.8 Grouped moves

It is easier to move all characters on a moving piece (cart,
siege tower, belfry, ships) as one. You can for instance group
all characters on a drakkar by wrapping them in the same
zone with your mouse (click and hold while wrapping). You
don't have to encompass the full surface of each element to
do so. You can also select/deselect each element separately
by clicking it while pressing the Shift key.

4.9 Turn marker

The turn marker is displayed by an 11th century Norman kite shield with a
number in its middle. It can be found in the Misc / Game Info tab of the

counter window. It is managed like any other counter: Drag and drop it on
the map, then increase the number at each turn in right-clicking the shield Srp—
and select Increase. The maximum number of turns is 20. Rotate SOW CTRLS

Increase CTRL Q
Decrease CTRLW

Clone CTRLC
Delete CTRL X
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4.10 Siege record sheets

Each extension featuring a castle or a fortified town adds a tab in the window accessed through the

Maps Record Sheet button in the controls menu.

A reduced view of this castle or town is displayed
when clicking on this button and then in the relevant
tab in a separate window.

The siege turn marker is represented by a tower with a
number in its middle. It can be found in the Misc /
Game Info tab in the counters window. It is managed
like any other counter: Drag and drop it on the map,
then increase the number at each turn in right-clicking
the tower and select Increase. The maximum number
of siege turns is 45.

The damage marker is included in the same tab. Drag
and drop it on the damaged wall hex, then increase the amount of damage at each turn through
right-clicking on the marker and select Increase. The maximum number of damages is 4.

4.11 Creating a scenario

A VASSAL scenario is just the set up of a map and counters in their starting position in a new
game that you save. The process is quite simple:

> Create the terrain by assembling one or several maps. Add the terrain features (stakes, doors,

portcullis, etc.) or overlays (Promontory maps, ships, walls under construction) that are
necessary to play the scenario.

> Add the turn marker in a corner of the map (see 4.8). You can choose to start from the

maximum number of turns defined by the scenario (12 for instance), then decrease to end at 0.

> If this is a siege scenario, put the siege turn marker on the siege record sheet (see Error!
Reference source not found.)

Put the various counters in their starting positions.
> Save the game under a new name and invite your opponents to join.
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